


Digital Imaging Basics

Every journey begins with the first step. Unfor-
tunately, for many, the temptation to skip the
first few steps is greatly enhanced by the com-
forting belief that they already know how to
take pictures. After all, we’ve all been snapping
photos since we were kids, haven’t we? Modern

cameras do everything automatically, don’t they?

Well, despite the fact that certain aspects of pic-
ture taking remain the same, you are striking
out into a vast new territory when you forge a
path into the digital wilderness. Before you
begin, you’ll need to learn the basics of how
digital photography works; then you’ll need to
set up your hardware and set your software
preferences for the best starting place for your
journey. Only then can you take the first tenta-

tive steps to digital photo mastery.

Chapter Contents
Chips and Pixels
Setting Up: Hardware
Setting Up: Software
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CHAPTER 1: DIGITAL IMAGING BASICS B N

Chips and Pixels

All cameras function like human eyes (Figure 1.1). In both, a lens focuses light through
a small hole (iris) onto a receptive surface (retina/film/chip) that translates the varying
intensities and colors of the light into some meaningful information. The main distin-
guishing feature between different cameras and the eye has to do with the receptive sur-
face. The eye’s retina is a receptive surface comprising two different structures (rods
and cones) with three basic color sensitivities (red, green, and blue). Film is made of
one type of structure (silver salt grains suspended in gelatin) with three different layers
to receive color. Digital camera chips have one structure of photoreceptor sites on a sili-
con chip, each of which has one of three different colored filters to record light.

Figure 1.1 All cameras function like human eyes.

Digital cameras are similar to eyes in that the camera’s chip translates the light
into information (electrical signals) directly. Much as the eye translates the light falling
on the retina into nerve impulses (electrical signals) that travel to the brain for process-
ing, the electrical signals from a digital camera require processing in a computer
“brain” before they can be used to create photos.

The actual process is rather more complex, but a few things are important to
understand. Most digital cameras capture images using chips with receptor sites that
have red, green, and blue filters arranged in a regular pattern on the surface of the chip.
Light intensity is the only thing captured at a receptor site. During the processing
phase, the color of light hitting a receptor is determined by calculating differences in
intensities between adjacent sites that have red, green, or blue filters. This process pro-
duces an RGB bitmap image. A bitmap is a regular grid of square units of color. These



units are called pixels. Color is determined by the relative values of red, green, and blue
for each pixel. We, therefore, think of these pixels as being in three “channels” (red,
green, and blue) simultaneously so that the complete image is recorded as three differ-
ent B+W images that form the full-color version. This concept will be important when
we get to color correction.

Bayer Pattern Chips

The usual arrangement of red, green, and blue photoreceptors across a digital camera chip surface
is called a Bayer pattern. This reqular pattern alternates green with red and blue so that there are
twice as many green pixels as there are red or blue. There are more green pixels because green
holds 60 percent of the overall image luminosity (lightness-darkness) in an RGB image. The signals
from adjacent pixels are averaged together using complex algorithms to determine the overall
color and interpolate this into each pixel in the image. Skin colors sit right between the red and
green filter frequencies used in most chip designs, and as it turns out, calculating skin color cor-
rectly is difficult. In digital photography, skin color can end up being a little too red.You'll learn
how to compensate for this later.

The number and density of receptor sites on the chip determine the resolution of
detail. This pixel count is given as either dimensions, such as 4992x3228, or as a total,
such as 16 megapixels, where “mega” means million (totals are usually simplified to the
nearest decimal). Therefore, an 8-megapixel chip has less resolution than a 12-megapixel
chip. Professional-quality people photography can be done with cameras delivering
5 megapixels or more of resolution. Pixel count can be manipulated after the fact through
mathematical calculations that interpolate new pixels from existing ones, but the amount
of image detail can never exceed the original resolution of the chip. That being said,
there is no reason for you to obsess over the number of pixels available as a standard
of quality. Movie posters have been made from images with fewer than 6 megapixels,
and the quality of those pixels is more important than the quantity used for photo-
graphing people.
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The dynamic range of a captured scene is an important yardstick for quality
(Figure 1.2). This is the brightness range from dark to light that affects how much
detail can be rendered in the darkest and lightest portions of the scene. Dynamic range
is often represented in f-stops. Digital cameras can often capture a range of 11 f-stops
from black to white, where a paper print from a desktop inkjet printer might have, at
best, a range of five f-stops. Regular offset lithography, such as magazine printing, has
even less dynamic range—typically four f-stops or even less. This disparity between
capture and output is at the heart of reproduction problems because we often have to
determine how we are going to compress the range of an image to fit the output. You
will often hear about “bit depth” in the same breath as dynamic range. Bit depth refers
to the number of steps between black and white that are encoded in a digital capture.
Higher bit depth captures have a finer density of steps and yield a smoother ramp from
black to white; however, bit depth does not determine dynamic range. It is certainly
better to have higher bit depth with wider dynamic range, but the two are not necessar-
ily interdependent.

Lower dynamic range Higher dynamic range Higher bit depth

Lighter

More steps

Darker

Figure 1.2 Dynamic range and bit depth

The RAW signal from the camera chip can be processed either in the camera
firmware or later in software under user control. There is some debate over the merits
of both approaches. Generally, if you opt to have the camera do the processing, you
will be shooting JPEG files to the memory card or directly to a computer.

Note: JPEG stands for Joint Photographic Experts Group, the organization that developed the file
format.



JPEG is a file format that was developed to reduce file size by using mathemati-
cal algorithms that simplify the pixel structure in the bitmap image. This process is con-
sidered lossy because some image detail is “lost” during the process. Digital cameras
apply a conservative level of compression or size reduction, and this is generally consid-
ered visually [ossless. This does not mean that there is 7o loss—just that the loss is not
apparent at first glance. Even the best JPEG file does not carry the same amount of
information or image detail as a noncompressed or unaltered version.

The main advantage to shooting JPEGs is that by compressing the file size, you
can fit many more images onto a memory card (so you don’t have to change cards as
often). Because the files are smaller, they also write faster and enable faster shooting
speeds. This can be important for shooting wedding candids, news, sporting events, and
any other fast-breaking action. The disadvantage to shooting JPEGs is that you have to
accept the camera’s interpretation—of color, contrast, etc.—and you limit the potential
quality of the image. You give up some flexibility and quality for speed and convenience.

JPEG Compression Artifacts

JPEG compression works by simplifying adjacent tones; similar tones are assigned the same value.
This can cause distinctive “blocky” artifacts and “messy” edges, which are most noticeable in
extreme magnifications. JPEG artifacts can become a problem when image files are sharpened for
print output or scaled up from smaller sizes. For most work destined for offset lithography (maga-
zines and newspapers), JPEG artifacts don't pose a problem because they are obscured by the
printing linescreen.
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If you are concerned with the best possible quality, then you probably will prefer
to record the camera’s RAW signal and process this data using your computer software
in a RAW file workflow. Doing so complicates the process slightly by adding an addi-
tional post-processing step to your photography workflow. We’ll cover this more
thoroughly in Chapter 2, “Color Management Workflow and Calibration.” The main
advantage to a RAW file workflow is that you can postpone final decisions on color
rendering, tone, and contrast until after the shoot, when you have fewer distractions
and you can concentrate on basic photo elements such as lighting, composition, and
exposure. You also gain a considerable amount of control over color rendering, tone,
and contrast. The disadvantage is that you have to take extra time after the shoot to
process your RAW files into a useable format.

Setting Up: Hardware

Covering all the available digital photo equipment is impossible. However, as topics
require, I will go over more hardware details in the remaining chapters. For now, I'll
just give a few general recommendations to consider regarding:

° Camera

o Memory cards

° Batteries

o TV monitor

o Computer

o Monitor and calibrator
Camera

Any digital camera is capable of taking great shots. However, getting great results is
easier if you have equipment that delivers quality. Most serious photographers will
require, at minimum, a DSLR (digital single lens reflex) camera (Figure 1.3) of at least
5 megapixels resolution. You’ll also want to make sure that your camera is capable of
shooting (and saving) RAW files. Even if you normally shoot only JPEGs, the ability to
shoot RAW will be important on some occasions, and it is often an indicator of a better
camera. All of the tutorials and exercises in this book can be completed using cameras
costing less than $800. If you are just starting out in digital photography, don’t be
temped to spend all your money on the camera body. It’s better to save some of your
budget for lenses and other accessories to build a complete system.

Memory Cards

After you purchase a camera, you’ll need to obtain memory cards (Figure 1.4). More
memory is better, but focus on procuring multiple cards rather than bigger cards—hav-
ing two 1GB cards is often better than having one 2GB card. You should have at least
three cards, but more will be handy if you don’t get the chance to download files dur-
ing a shoot. Stick to major brands, such as Sandisk and Lexar, and try to get the fastest
ones available. Mark your cards (A, B, C or 1, 2, 3, etc.) so you can identify which
cards go bad if you discover some file corruption. Also, arrange for some method of



separating shot cards from empty ones (I use two different colored Otter Box water-
proof cases). Finally, no matter what method you use to download images from the
card, do not erase the image files from the card using a computer; always format the

card in the camera you use to take the pictures.

Figure 1.3 A digital SLR camera makes it easier to get high-quality results.

Figure 1.4 Memory cards
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Note: You'l find Otter Box cases at http://www.otterbox.com/products/otterbox/
1000/.

Batteries

Digital photography is all about recording electrical signals, and that means batteries
are required! Make sure you have a lot of them. Just about all digital cameras require
nickel metal hydride (NiMH) rechargeable batteries (Figure 1.5). In many cases, regular
alkaline batteries can damage the camera. If your camera takes a special proprietary
type, get at least one extra for a backup and keep it charged. Don’t forget batteries for
flash units, radio slaves, portable card reader/players, or any other accessories you
might have. A good battery charger will more than pay for itself. Get something that

can reform or revitalize tired batteries that lose their ability to hold a charge.

Figure 1.5 NiMH rechargeable batteries

TV Monitor

High-end digital camera systems have the capability to shoot directly to a computer
through a Tethered Operation mode. This gives you a high-resolution display of every
shot as you take it, which is quite a luxury. Even relatively inexpensive DSLRs have a
video-out plug that can send the LCD preview signal to a TV monitor (Figure 1.6).
Although the picture resolution is not as high as a computer display, it is more than



adequate and quite a bit less expensive. It’s also quite a bit faster: my Canon EOS-1DS
Mark II in Tethered mode takes 7.5 sec to display on my computer monitor, but the
video preview is instantaneous. You can adjust the LCD preview delay to keep the
image up longer if you prefer, but it’s also a simple matter to review images on the spot
using the camera controls.

Figure 1.6 Camera with monitor

Note: Theimage displayed on the TV, like the LCD preview, is essentially the preset JPEG that the

camera would render from the RAW data. This may not be exactly the same rendering you would achieve N 2
using RAW processing software, so you probably won't be able to rely on the TV image for anything more @
than a quick review.

Computer

The platform wars are over! As far as basic functionality and speed issues go, Windows
and Macintosh computers are equivalent. If you are familiar with one or the other,
stick with the computer you have—there will be no advantage to switch just for digital
photography. The main software applications you will be using are cross-platform,
and the user experience is more or less the same with both computers. If you have not
invested heavily in computer hardware yet and you are primarily interested in commer-
cial advertising work, then you should consider a Macintosh only because it is the
platform of choice for the advertising and design industry. I have used Macintosh

HIAVAAIVH *dN ONILLAS W ©
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computers since 1985, and I’'m very happy with my computer experience. However, I
really can’t recommend one over the other. I apologize to the majority of readers who
will be using Windows machines because all the screenshots in this book are taken on
a Macintosh.

Regardless of your computer platform, you will want to load it with as much
RAM as possible—there is no such thing as too much RAM for image processing work.
This also goes for hard drive space. Again, you can never have too much; plan on hav-
ing a second hard drive that you can set up as a duplicate for backup purposes. Ideally,
you will also have additional drives to use for archiving. Investing in a good monitor
and monitor calibrator is absolutely necessary.

A minimal system will have:

o A computer

] A monitor plus monitor calibrator

o Two large hard drives (minimum)

o A CD/DVD burner

o An uninterrupted power supply (UPS), battery backup, surge protection
o A quality inkjet printer

o A card reader: FireWire or USB2 (shown here)

Monitor and Calibrator

A good monitor is an absolute necessity for any serious photographer. However, a good
hardware calibrator is even more important (Figure 1.7). LCD monitors have overtaken
CRTs in popularity, but the need for good calibration has never been in dispute. You’ll



need to purchase a calibrator with the necessary software and use it regularly to keep
your display in good working order. Even a mediocre display can be serviceable if it is
properly calibrated, but an expensive display is almost useless if it lies to you! Calibrate
your display every two weeks to be on the safe side.

Figure 1.7 Monitor calibration

Note: Many hardware calibration devices are on the market. Some popular systems are Eye-One Dis-
play (GretagMacbeth), Monaco Optix (X-rite), ColorEyes Display (Integrated Color), and BasICColor Display
(Color Solutions).

Before moving on to software preferences, you need to consider your computer
setup. I highly recommend that you choose a simple, gray desktop color and select a
gray interface option for the overall color scheme for your computer. The idea is to
eliminate as many color distractions as possible for the environment in which you will
be making color decisions. If the background behind your images is bright blue, you
will tend to see everything as warmer than it is because of the color contrast with the
blue background. You probably will have a tendency to make your colors too cool as a
result. A neutral gray background is the safest choice because it will not bias your judg-

ment one way or another.

-
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Setting Up: Software

Your digital camera probably came with software to process the RAW files that it pro-
duces. Many photographers are quite happy with their camera software. This book,
however, outlines professional procedures and techniques that go beyond the push-
button, preset mentality of most camera manufacturers’ software. Many software pack-
ages are available for professional digital photography. At the time of this writing, Apple
and Adobe have just released new applications targeted to the professional photographer.
I might include these or other new products in future versions of this book; but for now,
the most versatile and professional software for photographers is Adobe Photoshop. I
will concentrate on techniques and workflows that are used with Adobe Photoshop CS2,
Bridge, and Adobe Camera Raw.

The rest of this chapter will cover some basic preference settings to establish a
starting foundation for future explorations. We will cover:
o Photoshop preferences and color settings

] Bridge preferences and configuration

Photoshop: Preferences

The following pages cover various Photoshop CS2 preference settings in some detail.
These recommendations are designed for the photographer working to produce print
images; however, a thorough understanding of the preference controls will be handy in
any intended workflow. Many of Photoshop’s workspace customizing features will not
be covered extensively. You will have to investigate palette layout, tool presets, and cus-
tom brushes on your own. Individual needs in these areas will change and develop over
time, so it makes sense to skip over the details for now.

The screen shots presented here were taken in Mac OS X. For the most part, the
differences between Windows and Mac OS X are cosmetic. The main difference is that
the preferences are entered via the Photoshop menu in OS X (far left, application menu
next to the Apple menu) and preferences are entered via the Edit menu in Windows.

The other important difference is the way memory preferences are handled. Mac
OS X has a dynamic memory functionality that affects the preferences in Photoshop
CS2. Windows versions of Photoshop have an Image Cache preference setting where
you determine the number of Cache Levels; Mac OS X also has a Memory Usage set-
ting in the same dialog where you can limit the amount of memory that OS X will
assign to Photoshop. This limit is assigned in a fixed way in Windows outside of Pho-
toshop’s preferences.

Select from the Photoshop menu (OS X) or the Edit menu (Windows) > Prefer-
ences > General (Figure 1.8).



About Photoshop...
About Plug-In >
>

Preferences General...

Services > File Handling...

= = Display & Cursors...

Hide Photoshop _&BH Transparency & Gamut...
Hide Others X#H 1 nits & Rulers...

2l Guides, Grid & Slices...
Quit Photoshop 20 Plug-Ins & Scratch Disks...
Memory & Image Cache...
Type...

Figure 1.8 The preferences are found on the Main Menu bar,
under either the Photoshop or Edit menu.

Most of these settings are self-explanatory. For the most part, you can accept
the program defaults. I am going to discuss only items that you might want to
change. Your General preferences should look like Figure 1.9: Most settings that
are already checked here should be fine. Make sure that Interpolation is set to Bicu-
bic Smoother and that Export Clipboard is not checked. In most cases, you do not
want to carry the Clipboard over into other applications. If you forget to purge it,
an error can be reported or a serious delay can occur when you move between
Photoshop and another application. Bicubic Smoother is the best default interpola-
tion for scaling up files and it gives the smoothest result—smooth is desirable
with skin.

Preferences
& o)
Color Picker: | Adobe -é-]
Image Interpolation: [ Bicubic Smoother "'H
e 1y Changes will take effect the next
UlEant Sized @ \-) time you start Photoshop.
History States: |20
— Options
] Export Clipboard ] Beep When Done
E Show Tool Tips g Dynamic Color Sliders
E Zoom Resizes Windows ESM Palette Locations
] Auto-Update Open Documents (W] Use Shift Key for Tool Switch
E Show Menu Colors ] Automatically Launch Bridge

E Resize Image During Paste/Place || Zoom with Scroll Wheel
g 9

] History Log

Save Log Items To: (=) Metadata
_) Text File Choose...
_) Both

Edit Log ltems: | Sessions Only =3

(Reset All Warning Dialogs )

Figure 1.9 General preferences

-
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Note: Theinterpolation method selected here is just a default. It controls which method appears when
you first enter the Image Size dialog and it is the method used with Transform commands. In practice, you
are free to change the method used in the Image Size dialog by selecting from the Resample Image menu.
Although Bicubic Smoother is normally preferred for scaling up, Bicubic Sharper is most often preferred for
scaling down.

After you are comfortable with Photoshop, you’ll probably want to uncheck
Show Tool Tips to get rid of the little yellow notes that describe the function of icons
and tools when you hover your cursor over items.

History Log is primarily of interest for forensics or scientific work where you
might want a record of everything that was done to the file. Most of us won’t find this
feature particularly useful.

You can determine file-saving behavior in the File Handling panel (Figure 1.10).
Most users will want to check Always Save to save their previews unless they have
some consistent need to for smaller file sizes. The cost of storage is at an all time low,
so don’t economize unless you must. You can uncheck OS platforms that you do not
use for Thumbnail. Saving a Full Size image preview is useful with image cataloging
programs such as iView Media Pro, Cumulus, or Portfolio; if you don’t use a cata-
loging program, you should.

Preferences
File Handling -+ o)
— File Saving Options = : = :
Image Previews: Always Save ¥ :]
Elcnn EFuII Size Prev
E Macintosh Thumbnail ! {'ﬁlextk )
[ Windows Thumbnail
Append File Extension: = Always 'B-

# Use Lower Case

— File Compatibility
£ Ignore EXIF profile tag
[# Ask Before Saving Layered TIFF Files
E Enable Large Document Format (.psb)

Maximize PSD and PSB File Compatibility: | Always | C]

— Version Cue
") Enable Version Cue Workgroup File Management

Figure 1.10 File Handling preferences



I used to recommend against using Maximize PSD File Compatibility; this cre-
ates a composite layer (one layer with all other layers rendered into it) for compatibility
with Photoshop 3. Now, though, I recommend that you set this to Always; the reason,
again, has to do with image cataloging programs. If there’s no composite layer, many
programs cannot generate a thumbnail to use in the catalog. You should also have
Always selected for Append File Extension.

Some cameras will report their color space as SRGB even when they don’t have
an embedded profile. Ignore EXIF Profile Tag prevents this problem. You should leave
Ask Before Saving Layered TIFF Files checked, if only as a double check for when you
are saving TIFFs. Currently, Photoshop is the only program that can open layered TIFF
files. The only reason to save a file as a TIFF is for maximum compatibility with other
image applications, and you would negate this if the file has layers. (Save layered files
as Photoshop PSD documents and save yourself some grief later.) Enable Large Docu-
ment Format (.psb) does just that—Dbut at the expense of some backward compatibility.
I don’t see this as a problem; however, unless you need to save files that are larger than
2GB, checking it isn’t critical.

Display & Cursors is shown in Figure 1.11. Do not check Color Channels In
Color. Viewing color channels as grayscale luminosity is a lot more useful. By checking
Use Pixel Doubling, you can increase the speed at which moving objects are drawn on
the screen and layers are repositioned; however, moving objects will be rendered with
less fidelity. I find the option distracting, so I leave it unchecked. Cursors should always
be set to Brush Size and Precise; I prefer to check Show Crosshair In Brush Tip because
the feature is very handy when lining up the Rubber Stamp tool. Full Size Brush Tip
draws the circle for the brush size at the outer edge of the feather in a soft brush; it
sounds like a good idea, but it drives me crazy so I leave it unchecked.

Preferences
Display & Cursors | 3‘! m
By { Cancel )
("] Color Channels in Color

] Use Pixel Doubling

— Painting Cursors — Other Cursors

-~ s

() Standard () Standard
) Precise @ Precise
® Normal Brush Tip

() Full Size Brush Tip

B Show Crosshair in Brush Tip

Figure 1.11 Display & Cursors preferences
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Transparency & Gamut (Figure 1.12) controls the appearance of transparent
parts of image layers. I find the default gray-and-white square distracting when I
examine masked edges. I recommend that you change the white squares (click the
white Grid Colors patch to bring up a color picker) to a gray value that’s just barely
different.

Preferences
Transparency & Camut I%J Trr—
— Transparency Settings ( Cancel >
Grid Size: [ Small )
Grd olors: (Crvom 19}

) Use video alpha (requires hardware support)

— Gamut Warning

Color: . Opacity: (100 EB %

Figure 1.12 Transparency & Gamut preferences

In Guides, Grid & Slices (Figure 1.13), you might have to uncheck Show Slice
Numbers; however, that that’s the only thing you might have to change here. If you
inadvertently select the Slice tool instead of the Brush tool, you can end up with little
numbers in the upper-left corner of the image window; most photographers find them
distracting. Slices are used to divide an image into sections that will load separately in a
web browser; this helps speed up the display of large graphics—obviously, this is
important for web designers.

The Plug-Ins & Scratch Disks dialog is shown in Figure 1.14. If you end up with
lots of third-party plug-in filters, you can limit the number of filters that load in any
given session by designating an Additional Plug-Ins folder. By holding down 8-Option
(Mac) or Ctrl-Alt (Windows) at the application launch, you can select or deselect the
extra plug-ins. Limiting the number of available plug-ins can free more memory for
Photoshop and accelerate certain functions. Scratch Disks allows you to select up to
four separate disks for Photoshop’s temporary “scratch” memory. You can obtain a
speed boost by setting aside an empty hard drive (or, at the very least, a separate parti-
tion) exclusively for a scratch disk. Extra disks serve as spillover memory for the main
scratch in descending order of priority.



i Preferences

— [ Guides, Grid & Slices }—:g

— Guides

Color: | [JCyan B
Style: ' Lines B

— Smart Guides

Color: | [Magenta B

H
il

— Grid

Gridline every: ,1_| @
Subdivisions: ’4—|

— Slices

Line Color: | [llLight Blue B

QShm Slice Numbers
"

Figure 1.13 Guides, Grid & Slices preferences

i Preferences
— | Plug-Ins & Scratch Disks =) E i
# Additional Plug-Ins Folder —
DualBoot-38gig:Applications:Adobe Photoshop CS2:ExtraCrap: Choose...
[ Prev )
Legacy Photoshop Serial Number:
- Scratch Disks — —
First: | Scratchy-10gig h@"
Second: | MaxtorBackup )
Third: [ Torah-85gig m
Fourth: [ LaCie Disk )

1y Scratch disks will remain in use
\-4) until you quit Photoshop.

Figure 1.14 Plug-Ins & Scratch Disks preferences

Memory & Image Cache (Figure 1.15) can usually be left at the defaults. Win-
dows and Mac versions look a little different. 'm showing only the Mac version
because its Memory Usage option is a little confusing. Mac OS X has a special dynamic
memory allocation feature that allows the foreground application to gobble up mem-
ory as needed. Photoshop is particularly greedy with RAM; therefore, in certain

-
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circumstances you’ll need to limit the amount of RAM to which it has access. If you
have more than 4GB of RAM installed, you can safely assign 100 percent as the Maxi-
mum Used by Photoshop because Photoshop can access only up to 4GB anyway. If you
don’t have that much RAM, giving in to Photoshop’s memory demands can be danger-
ous because you can starve the operating system (OS) and force it to swap memory in
and out of the hard disk. More is not always better when you make Photoshop RAM
assignments. If the OS has to work harder at managing memory, Photoshop operation
can actually slow down. If Photoshop seems slower after you’ve assigned more RAM,
lower the RAM assignment to leave more for the OS.

Windows memory management is a little more straightforward. You assign the
specific amount of memory to which Photoshop has access. The only trick is to make
sure you have enough memory left over for the OS.

Preferences

Memory & Image Cache | H @
f_ Cache Settings ( Gancel )
| Cache Levels: |6

M : :)
emory Usage . N
Available RAM: 1471MB
| Maximum Used by Photoshop: |60 [3 % = BB2MB

/1y Changes will take effect the next
2 time you start Photoshop.

Figure 1.15 Memory & Image Cache preferences

The next area you have to set up is Photoshop Color Settings. From the Main
Menu bar, choose Edit > Color Settings. The Color Settings dialog (Figure 1.16) is
where you determine the default color management behavior of Photoshop. For our
purposes, change the Settings drop-down from North America General Purpose 2 to
North America Prepress 2. This will set the rest of the dialog to the most appropriate
defaults. We’ll go over color management in more detail later because the topic comes
up repeatedly in our workflow. For now, just realize that we’ll use Adobe RGB as the
default color space for all our digital photo files and we’ll be using ICC profiles to
define the colors with which we’ll work.



Color Settings

For more information on color settings, search for
“setting up color management” in Help. This term

is searchable from any Creative Suite application. Cancel
— Setti [ North America Prepress 2 ﬁ— Load...
— Working Spaces
RGE: | Adobe RGB (1998) )
CMYK: [ U.S. Web Coated (SWOP) v2 =] More Options
Gray: [ Dot Gain 20% 3] ™ Preview
Spot: [ Dot Gain 20% ]

— Color Manag Policies
RGB: | Preserve Embedded Profiles

CMYK: | Preserve Embedded Profiles
Gray: | Preserve Embedded Profiles |3
Profile Mismatches: (W Ask When Opening W Ask When Pasting
Missing Profiles: ¥ Ask When Opening

— Description
North America Prepress 2: Preparation of content for common
printing conditions In North America. CMYK values are preserved,
Profile warnings are enabled.

Figure 1.16 Color Settings dialog

Bridge: Preferences and Configurations

We will be examining the Bridge workflow; Bridge (Figure 1.17) is the file browser
application that is part of Adobe’s Creative Suite.

GXEXG) 1-gig - Adobe Bridge

<% o (@ 1-gig B ] whteed > @ O T | F |2

Ap B3 ltems, 63 hidden 5 e—ti— | [ 2@ 3= i

Figure 1.17 Adobe Bridge

-
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At this point, we need to go over only a few of the preference settings. When
you first open the Preferences dialog, you will see the General preferences (Figure 1.18).
This area controls the appearance of thumbnails and determines which items appear in
the Favorites tab. Click the Reveal button to display the locations for the JavaScripts
that Bridge accesses for some of its automation features.

Preferences
Coneral [
Metadata -
Labels - Thumbnails
File Type Associations Background: Black White
Advanced
Adobe Stock Photos # Show Tooltips
EmailSupport
PP Additional Lines of Thumbnail Metadata
| Show: | Date Created &
| Show: | Dimensions I%!
I Show: | Keywords | :!
- Favorites Items
=) Bridge Center E Computer
] Adobe Stock Photos "] Version Cue
# Collections "] Adobe Photographers Directory
g Home 8 Desktop
g Documents E Pictures
( Reveal ) Reveal Scripts in Finder
( Reset ) Reset All Warning Dialogs
( Cancel ) HH

Figure 1.18 Bridge General preferences

Metadata preferences (Figure 1.19) determine what metadata fields will be visi-
ble in the Metadata tab. Metadata is simply data about data; the data we’re interested
in is, of course, the image file. You can turn off the display of anything you’re not
interested in by unchecking that item in the list. Don’t get too carried away and turn
off too many fields—you don’t have to look at them all the time. Make sure you check
Hide Empty Fields to prevent the display of fields for which there is no data.

The only other preference worth noting at this point is the Advanced prefer-
ences (Figure 1.20). In this dialog, you specify the maximum size for files that Bridge
can process (200 megabytes is the default). You can use Do Not Process Files Larger
Than to prevent Bridge from wasting time building thumbnails for huge layered files.
By checking Double-Click Edits Camera Raw Settings In Bridge, you can open RAW
files into Camera Raw without launching Photoshop; this setting is sometimes more
convenient than always launching Photoshop. You should check Use Distributed
Cache When Possible because it places the Camera Raw XMP and Bridge cache files
in the same folder as the RAW files. This can be an advantage when you are moving
or backing up data because Bridge won’t have to rebuild thumbnails for folders
you’ve already seen.
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Figure 1.19 Bridge Metadata preferences
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Number of Recently Visited Folders to Display in the Look In Popup: 10/

# Double-click edits Camera Raw settings in Bridge
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~Cache

When Saving the Cache:
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Figure 1.20 Bridge Advanced preferences

To start using Bridge, simply select a folder of images in the Folders tab. Bridge
will render size-adjustable thumbnails for image files in that folder in the main window
pane in the interface (Figure 1.21). There are many ways to configure the Bridge inter-
face, and we won’t cover all of them. However, I would like to point out one configu-

ration that I find useful and that is not particularly obvious.
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Figure 1.21 Bridge default layout

The default layout for Bridge has image thumbnails in the main window with vari-
ous navigation and information tabs in three window panes at the left. You can choose
different layouts from the Window menu (Window > Workspace > Lightbox, File Naviga-
tor, Metadata Focus, or Filmstrip Focus), or you can make your own custom layout. I
like to nest all of the tabs into one window pane. Click and drag each tab into the top
window pane—everything will collapse into one pane with a long list view (Figure 1.22).
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Figure 1.22 Bridge’s long list view



You can save any custom layout you want from the same Window menu (Win-
dow > Workspace > Save Workspace); your layout will then appear at the bottom of
that submenu. I find this long list view very handy for navigating through folders.
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